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1 ConfigWiz® Introduction 

1.1 About ConfigWiz® 

During the past decade, Supervisory Control and Data Acquisition (SCADA) systems have 
evolved into important subsystems of the enterprise-wide information network, providing 
enhanced functionality in addition to their traditional roles of remote monitoring, telemetry, and 
control. This enhancement, in combination with rapidly developing automation requirements, 
makes the configuration of SCADA system components a complex task.  

ConfigWiz combines a user-friendly Graphical User Interface (GUI) with an application-
specific organization that reduces the possibility of configuration errors. It also provides a set 
of carefully selected defaults that should be sufficient for initial operation of most systems. 
However, to effectively use ConfigWiz, the user must possess a thorough understanding of 
the SCADA system. In particular, the user must understand the system requirements for 
interconnection of field devices or Intelligent Electronic Devices (IEDs) with an RTU. The user 
should also have a well-organized configuration plan regarding requirements for functionality, 
information transfer, and performance. With this plan, as well as all system block diagrams 
and data points lists, the user will be ready to determine and select the correct parameters for 
system configuration.  

IEDs are the most common source of real-time information in substations because they are 
capable of serving an extensive amount of data. Unfortunately, the typical communications 
link between master stations and substations is still very limited in bandwidth and data 
throughput capability. The response time of a SCADA system is inversely proportional to the 
amount of data being transmitted on the communications channel. This means that the 
system response decreases as data volume increases. This potential “bottleneck” demands 
great care in determining the most efficient configuration to ensure vital data throughput 
without wasting bandwidth. 
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1.2 SCADA Overview 

SCADA systems enable three core functions:  

• Autonomous function of downstream equipment 

• Automated data collection  

• Control of downstream equipment 

By design, SCADA systems offer remote data gathering and control. SCADA systems usually 
have a control center to serve and collect data from substations. The substation, in turn, 
communicates with and may control IEDs and field devices. This interconnection of field 
devices and IEDs with substations facilitates the three core functions of the SCADA system.  
At the substation, communication and control of the field devices and IEDs is processed by 
the RTU. 

The RTU contains master station servers that communicate with master stations. The RTU 
also contains field device clients that communicate with field devices and IEDs. The field 
device clients interpret protocols of the field devices using drivers and convey the interpreted 
information to the master station server. The master station server conveys the information 
from the field device clients to the master station.  

 

 

NOTE:  This example of a communications configuration displays two master stations. Most 
communication configurations will have only one master station, but some may have 
more than one. 
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ConfigWiz enables custom configuration of data points communication from field devices and 
IEDs to field device clients. The field device clients then can be configured to communicate 
selected data points to the master station server that communicate the data points to the 
master station. All communications parameters from field devices to master stations can be 
carefully configured by using ConfigWiz for optimum performance. 

1.3 ConfigWiz Package 

There are three main components of ConfigWiz: 

• Software program 

• Template file 

• RTU file 

The software program is called qconfig.exe and uses a standard template file to enable the 
user to configure custom RTU files.  A standard template file is provided with the software 
program.  Updated template files can be used with the software program as they become 
available.  

When beginning a ConfigWiz session, the user is prompted to choose a template file.  It is 
important for the user to be fully knowledgeable about the system and its communications 
requirements. Without knowing the field devices that are present in the system or what 
protocols they use to communicate, it is difficult to configure an RTU file using ConfigWiz. 

1.4 Communication Layers Concept 

The communications layer concept presents a view of the communication software 
architecture by functional definitions. Each layer presents a different view of the same 
communication configuration by its function. The communications layers are: 

• Application Layer 

• Link Layer 

• Physical Layer 
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 1.4.1 Application Layer 

The application layer defines the information that is communicated from the field devices to 
the master stations and defines the protocols used. In the application layer the field device 
clients for specific field devices are chosen, which is determined by the field device protocol. 
Then the data points are chosen from that field device client for the specific details of 
information that they convey.  

For instance, assume a variety of voltage readings need to be monitored on identical field 
devices that use the same communication protocol.  The user selects a field device client with 
a driver that communicates and interprets the same protocol as the field devices. After 
selecting the field device client, the user selects all the vital data points from the available data 
points to be communicated to the server by filtering them when the option is available. It is 
critical that the user only selects vital data points to ensure the most efficient throughput of 
information. 

 

 

NOTE:  This example of a communications configuration displays two master stations. Most 
communication configurations will have only one master station, but some may have 
more than one. 



 Configwiz User Guide        UM-2012  

Copyright © 2019 QEI, LLC Communication Layers Concept  •  7 

1.4.2 Link Layer 

The link layer defines the path that the communication software uses to direct the information 
from the field devices to the master stations. In the link layer the user maps the path that the 
RTU uses to direct communication flow from the field devices to the field device clients, from 
the field device clients to the master station server(s), and then from the master station 
server(s) to the master station(s). 

For instance, assume that the voltage reading data points need to go to two master stations. 
The user must map all of the same data points to two different servers. By mapping the data 
points, the user is defining the path that the RTU will use to direct the information flow.  

 

 

NOTE:  This example of a communications configuration displays two master stations. Most 
communication configurations will have only one master station, but some may have 
more than one. 
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 1.4.3 Physical Layer 

The physical layer defines the physical apparatus configuration that the RTU uses to 
communicate information from field devices to master station(s). In the physical layer the user 
configures the communication ports on the processor board and selects the type of 
connections used and the speed of the connection. 

For instance, assume now that field device clients have been selected by matching them to 
the field device protocol. And the data points from the field devices that the user has deemed 
critical are mapped to the master station server(s). The user needs to configure the ports, 
connection type, and connection speed that are used to transmit the information to and from 
the RTU.  

 

NOTE:  This example of a communications configuration displays two master stations. Most 
communication configurations will have only one master station, but some may have 
more than one. 
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1.5 Before You Begin 

ConfigWiz is an easy-to-use configuration tool with a friendly GUI.  However, it is very 
important that the user plan the work to be performed prior to using ConfigWiz so that the 
configuration proceeds smoothly and efficiently. Without a good understanding of the system 
to be configured, knowledge of the equipment used in the system, and data throughput needs 
to attain maximum efficiency, it is not advisable to attempt any system configurations. The 
best-suited individuals for initial configuration of systems should be involved with the needs 
assessment, design, and implementation of the system. Individuals that have this type of 
intimate involvement with the system facilitate the speed and accuracy of initial configurations. 

It is important that the user understand the role of ConfigWiz as a tool.  This tool enables the 
user to easily select and input system parameters and configure the system, but it does not 
perform any system needs analysis.  For this reason, it becomes clear that planning and 
coordination before using ConfigWiz is very important. There should be no doubts as to 
specific information that must be entered into any of the various fields in the software 
package. ConfigWiz does not make suggestions for system configuration parameters, 
although there are system defaults, these are not always the most effective for every system. 
Knowing the most efficient system configuration is left to the system designer. 

This manual covers all of the fields, windows, and commands necessary for configuring any 
system, but the specific information needed for your system is not covered because all 
systems are different. Some of the common items that should be available or known before 
and during a system configuration are listed below. 



Configwiz User Guide        UM-2012 

 

10  • System Configuration Requirements Copyright © 2019 QEI, LLC  

 
1.6 System Configuration Requirements 

Users must be familiar with all items in system configuration requirements before attempting 
any system configurations. It is also important to have all system configuration parameters 
prepared before attempting any system configurations.  

• SCADA systems expertise – users must possess good knowledge of their system 
and its functionality including: 

- Understanding of IEDs or field devices and their data acquisition capabilities 
- Understanding of client/server relationships 
- Understanding of service provider connections 
- Understanding of RTUs as communications processors and data acquisition   
concentrators for substations 

• System block diagram – depicts the system layout of field devices, and actual 
specifications of the equipment in place. The system block diagram should be 
prepared before any equipment is put in place and before ConfigWiz is used. It is 
necessary to have the system block diagram during configuration because it may 
depict custom names given to field devices that should be reflected in the RTU 
configuration. 

• Substation block diagram – depicts planned port assignments, transfer rates, type 
of connection with the service provider and the interconnection of the RTU with field 
devices and/or IEDs. The substation block diagram should be prepared before any 
equipment is put in place and before ConfigWiz is used. It is necessary to have the 
substation block diagram during configuration because it provides all interconnection 
specifications. 

• Data Point Map Plan – lists all data points to be transmitted from field devices to the 
master station. The data point map plan should be prepared before ConfigWiz is 
used. It is necessary to have this plan available during system configuration. 

• System Performance Requirements – specifications for information transfer rates 
that are required for optimum system performance. The system performance 
requirements should be prepared before any equipment is put in place and before 
ConfigWiz is used. It is necessary to have these requirements documented and 
available during system configuration. 

• Windows® 98 and up – operating environment needed to install and use ConfigWiz. 
The user must be familiar with the Windows environment and be able to use a 
mouse, select function buttons, and drag and drop icons. 

• ConfigWiz – tool used for configuring aspects of data communication from field 
devices to master stations.  

• Template file – The latest template file should be used for the configuration. 
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1.7 About this Manual 

This manual is arranged to enable the user to progress rapidly from installing the software, to 
becoming familiar with the tools available, and finally to configuring an RTU.  

It includes the following sections: 

• General overview of SCADA systems and theory of systems configurations. 

• Important information that the user should possess before attempting any system 
configuration. 

• Minimum requirements for software installation and provides installation instructions. 

• Tools available in ConfigWiz and instruction for beginning a system configuration. 

• Steps for adding communications components. 

• Ports configuration. 

• Filtering data points.  

• Mapping data points. 

• RTU configuration. 

• Configuring Tools 

• Writing the RTU file to the platform. 

• Commons terms and definitions.  

 

NOTE: This manual should be read in its entirety before attempting any actual RTU 
configurations.   

NOTE: The illustrations used in this manual may reflect a different ConfigWiz version from 
the current version.  
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2 Installing ConfigWiz 

2.1 About Installation 

ConfigWiz is designed to operate on an IBM®  compatible PC platform. The software consists 
of one CD containing the program and templates. 

2.2 Minimum System Requirements 
ConfigWiz requires the following pc hardware and software: 

• Windows® 98 and up 

• Intel® Pentium 133 processor 

• 16 MB Ram 

• 10 MB of free hard drive space 

• CD drive 

To install ConfigWiz, do the following: 

1. Obtain applicable licensing prior to installation. 

2. Close all Windows applications and disable any automatic virus detection software. 

3. Insert the ConfigWiz CD into the CD drive. 

4. A window will appear with a number of options, select the ConfigWiz option on the 
screen and follow the on-screen instructions. 

 

NOTE:  If the CD does not automatically display a menu, double-click on the “autorun.exe” file 
in the root of the CD. 

NOTE:  The installation of STunnel and SSL is automated and installs to the \security folder 
under the ConfigWiz root folder. 

2.3 Configuring Windows 7/10 to interface with DIO-94xx USB 

Maintenance Port. 
 

• See Addendum A for Step-by-Step instructions.  Contact QEI Customer Service Department 
for Driver download details. 
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3 Using ConfigWiz 

This chapter provides information about using ConfigWiz. The Functional Overview section 
gives descriptions of the commands and activities that are commonly performed. The 
Sequence of Actions section provides detailed instructions for the most common ConfigWiz 
tasks.  

3.1 Functional Overview 

ConfigWiz users will generally perform some, if not all, of the activities in this chapter and the 
chapters that follow. It is recommended that users become familiar with the GUI functions and 
commands before beginning a system configuration. 

3.2 Pull-Down Menus 

The pull-down menus contain the functional tools used to accomplish ConfigWiz tasks.  It is 
important to be familiar with the logic and organization of the menus. The menu bar of the 

ConfigWiz window contains the File, Components, New, Tools and Help pull-down menus.  

 

3.2.1 File Menu 
Open Template Opens an RTU template from available template files. 

New RTU Begins the configuration of a new RTU. 

Open RTU 

Open IED 

Opens an existing RTU or IED file on the computer.  NOTE: Modifying an 
existing RTU or IED file may affect the format or sequence that data is 
transmitted or received by the master station server or field device clients. 
Consider your changes carefully. 

Save RTU Saves the RTU file to the computer. NOTES: When saving an RTU file or 
writing an RTU file to platform, ensure that there are no spaces in the file 
name. For example, use the standard MS-DOS 8.3 file naming convention 
(filename.ext or nnnnnnnn.xxx).  It is highly recommended that users save 
work often. Saving an *.rtu  file requires a minimum configuration of one 
server and one client. 

Flash/NIA Loader  Provides two functions: (1) writes the S19 program file to the RTU processor, 
and (2) if the RTU is equipped with a 6NIA1 Network Interface Adapter, 
writes the required software to the 6NIA1. 

Read RTU file 

from Platform 

Reads the RTU file currently in use by the 6ACP5 or 6CPP6 processor 

board.   

Write RTU file     

to Platform 

Writes the RTU file to the 6ACP5 or 6CPP6 processor board. 

Note : When saving an RTU file or writing an RTU file to platform, ensure 
that there are no spaces in the file name. For example, use the standard MS-
DOS 8.3 file naming convention (filename.ext or nnnnnnnn.xxx). 

View Component Displays, prints, or saves in Comma Separated Variable (CSV) format all the 
configuration data available. 

User Preferences Allows the user to select different options. 

Exit Closes ConfigWiz. 

3.2.2 Components Menu 
Master Stations Lists all the available master station servers in the present configuration.  

Field Devices Lists all the available field devices (IEDs) in the present configuration. 
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 Ports Displays the Port Configuration window.  

RTU Displays the RTU Properties window.  

Components Displays all the available components in the present configuration. 

Users Displays and configures users 

 

3.2.3 New Menu 
New RTU Deletes all existing components in the present configuration and opens a 

new configuration. 

CAUTION 
If an existing configuration is not saved, the configuration will be lost. 

New Master Adds master station servers to the present configuration.  

New Field Device Adds a field device (IED) client to the present configuration.  

New Component Adds a component to the present configuration. 

 

3.2.4 Tools Menu 
Tunnel Config Displays the Tunnel Editor window that displays all currently configured 

STunnel entries.  The window allows adding new STunnel entries or to edit 
existing ones. 

Start stunnel Starts the STunnel program for download/upload security. 

Kill stunnel      Stop the STunnel program 

Run UCA Config Runs the GOMSFE Model Editor which is used to create UCA IEDs 

Make SEL IED Runs the SEL extraction utility which is used to create SEL IEDs 

IED Library Display the IED Library window.  The IED Library can be used to add IEDs 
to or save IEDs from the present RTU configuration. 

 

3.2.5 Help Menu 
About Displays ConfigWiz version, Template version, and if connected to the 

6ACP5 or 6CPP6 processor board, displays the RTU link version. System 
Information is a standard feature of Windows and displays information 
about the operating system. 
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3.3 Right-Click Pull-Down Menus 

Selecting device icons in the ConfigWiz window by right-clicking on them prompts a pull-
down menu. The right-click pull-down menu contains commands that vary according to the 
device that is selected.  Some general examples of the right-click pull-down menu commands 
for field device clients and master station server are shown below. 

3.3.1 Field Device Client Pull-Down Menu 

 

Filtering Displays the IED Point Mapping window.  NOTE: Not available for some of 
the field devices. 

Driver Displays the Driver window for configuring the client driver parameters 
common to all field devices of that type. 

Properties Displays the Properties window for configuring parameters for the 
particular field device. 

Rename Displays the Rename IED window for renaming field device icons. 

Save As Displays the Save As window for saving IED files. 

Duplicate Duplicates the field device client icon and all of the data point 
configurations. 

Resize NOTE: Not available for some of the field devices.  

Displays the Point Resizing window for resizing the total number of points 
available to the client from the field device. 

Remove Removes the selected field device client from the configuration. 

 

3.3.2 Master Station Server Pull-Down Menu 

 

Mapping Displays the RTU to Master Station Point Mapping window. 

Properties Displays the Properties window for master station servers. 

Remove Removes the selected master station server from the system configuration. 



Configwiz User Guide        UM-2012 

 

16  • View Component Copyright © 2019 QEI, LLC  

 
3.4 View Component 

This selection, found under the File pull-down menu, is a powerful feature that presents 
summary information about the configuration that is open or in progress. To view, click on a 

“+” symbol to expand the tree or click on a “-“ symbol to collapse the tree. Items selected in 
the left pane appear in detail on the right. Values are shown within and without brackets. 
Values in brackets represent arrays.  

 

 

Field Name Description 

Show All Fields Displays all fields.  If not selected, only displays the fields that are show in 

the Properties window. 

Expand Arrays Displays an array in expanded mode. Reselect the items you wish to view in 
that mode. Deselect to collapse arrays. 

Portrait/ 

Landscape 

Select either Portrait or Landscape for the print view. 

Save to File Saves the complete configuration to a file for viewing and analysis.  The file 
is in comma separated variable (CSV) format. 

Print Prints the complete configuration. 

Exit Exits the Component Display window. 

 

TIP: The Save to file command can also be used as a means of quickly expanding the 

view, in addition to creating a file/record of the configuration information. The Save to 

file command saves everything displayed in the left pane to a file after expanding the 
tree automatically. 



 Configwiz User Guide        UM-2012  

Copyright © 2019 QEI, LLC About This Section  •  17 

4  Sequence of Actions 

4.1 About This Section 

This section describes steps for opening ConfigWiz and beginning a configuration.  To begin 
using ConfigWiz, do the following: 

1. From the desktop, click Start, Programs, ConfigWiz.  The ConfigWiz - Plus main 
window is displayed for 30 seconds. 

2. If a template was previously never selected, the Open Template window is displayed.  

Select a template from the list and select Open.  

3. Begin configuring a new RTU file, or, select Open RTU from the File pull-down menu 

to display the Open RTU window and select an existing *.rtu file to work on, or, select 

Read RTU File From Platform to upload the current RTU file stored in the 6ACP5 or 
6CPP6 processor board. 

4. If a new master station server or field device client type is added, the S19 link file 
used in the RTU processor may need to be updated.  The Flash/NIA Loader is used 
to update the RTU Processor. 
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4.2 Flash/NIA Loader 

 

The Flash/NIA Loader is a feature in ConfigWiz designed to load both the 6CPP6/6ACP5 
processor board and the 6NIA1 Network Interface Adapter board.  The Flash/NIA Loader 
downloads files from a serial port on the user’s PC to the Test Panel port (port 3) on the RTU. 

The Flash Loader downloads a link (.s19) file to the 6CPP6 or 6ACP5 processor board.  The 
NIA Loader downloads up to three files to 6NIA1 board; the OS (.os) file, the Program (.pg) 
file, and/or the Boot (.img) file. 

The NIA Loader will not function if the 6CPP6 is not equipped with a working, properly 
installed 6NIA1 board.  For more information on the 6NIA1, please refer to UG-1040, 6NIA 
User’s Guide. 

CAUTION:  The Flash/NIA Loader is only to be used by trained personnel or under the direct 
supervision of trained QEI Automation personnel.  Failure to follow this guideline may cause 
the 6CPP6/6ACP5 and 6NIA1 to be not properly programmed, resulting in erroneous 
operation. Using the flash loader with the serial port must be done using Windows XP. 



 Configwiz User Guide        UM-2012  

Copyright © 2019 QEI, LLC Flash/NIA Loader  •  19 

4.2.1 Flash Loader 

When writing a new S19 link file to a running RTU, it is recommended to disable the controls 
and be aware that the RTU will not communicate with the Master Station during the download 
period. After a successful download, the RTU will restart and begin executing the new link file. 
Any failures during the download will cause the RTU to revert to the previously installed link 
file. In this instance you can retry the download sequence.  

Notice that during flashloading, the Spare LED flashes alternatively with the Heartbeat LED. 
After a successful download the Spare LED will stop flashing and the Heartbeat LED will 
continue flashing. It should be noted that when downloading an RTU file, the Spare and 
Heartbeat LEDs will flash together; after a successful download, the Spare LED will stop and 
the Heartbeat LED will continue to flash. 

In rare instances during download failures or RTU failures it is possible for the RTU to be 
unable to run the new or old link file or communicate with the Flash/NIA Loader or Test Panel. 
When this situation occurs, you must power down the RTU, set the “Load Default Tables” dip 
switch to ON, power up the RTU, restore the dip switch to its original setting and then try the 
download again.  For the 6CPP6, the “Load Default Tables” dip switch is S1, #8, and for the 
6ACP5, the dip switch is S2, #8.  Refer to the 6ACP5 or 6CPP6 processor board User’s Guide 
for more information on setting dip switches. 

If this is unsuccessful, power down the RTU, then set switches S1,7&8 on the 6CPP6 or S2, 
7&8 on the 6ACP5, power up the RTU, reset the switches, and try the download again.  After 
the new program file is written, reset the switches. 

You must write the original RTU file if the “Load Default Tables” switch was set.  Any time that 
this switch is set to ON and the RTU restarts, the RTU configuration file is replaced with a 
default RTU configuration file. The board only checks this switch when the RTU restarts. 

If the 6NIA1 Network Interface Adapter is present, resetting the board to ‘Load Default Tables’ 
is slightly different.  In addition to the switches already mentioned, switch S1,5 must also be 
turned on prior to power down, and then reset to off after the 6CPP6 has been reloaded.  

To Flashload, do the following (note that using the flashloader through the serial port must be 
done in a Windows XP environment): 

1. From the File menu, select Flash/ NIA Loader.  The Flash/NIA Loader window is 
displayed. 

2. Select the serial port from the list of the PC’s available serial ports. 

3. Select 6CPP6, 6ACP5, or 6DIO as the target.  Do not use the 6NIA as a target, this is 
reserved for QEI Automation  personnel only. 

4. Select the BaudRate from the dropdown list.  The options may change based on the 
target selected. 

5. Select the link file using the browse button located at the end of the Link: field.   

6. To load the link file, select the Execute button.  A popup window will appear which will 

provide information about the download.  Select the OK button to continue. 
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 4.2.2 NIA Loader  

When writing new files to the 6NIA1 on a running RTU, it is recommended to disable the 
controls and be aware that the RTU will not communicate with the Master Station during the 
download period. The RTU will restart at the end of the download. 

Notice that during the download, the Spare and Heartbeat LEDs on the 6NIA1 board will 
alternately flash.  After a successful download, the Spare LED will stop flashing and the 
Heartbeat LED will continue flashing. 

To load the 6NIA1, do the following: 

1. From the File menu, select Flash/ NIA Loader.  The Flash/NIA Loader window is 
displayed. 

2. Select the serial port from the list of the PC’s available serial ports. 

3. Select the 6CPP6 as the target.  Do not use the 6NIA as a target, this is reserved for 
QEI Automation personnel only. 

4. Select the BaudRate from the dropdown list. 

5. Select the OS, Program, and/or Boot files using the browsing buttons located at the 
end of each field.  You can choose to download one, two, or all three files, however, it 
is strongly recommended that you download a complete set of files.  If these files are 
not a matched set, do not continue.  You will not be able to use the 6NIA1. 

6. To load the selected files, select the Execute button.  A popup window will appear 

which will provide information about the files being downloaded.  Select the OK button 
to continue. 

7. To determine which files are loaded on the 6NIA1 board, set the Serial Port, 
BaudRate, and 6CPP6 as the target, but do not specify any files to be downloaded.  

Then, select the Versions button.  The Flash/NIA Loader will report back with the 
software part numbers and versions loaded for the OS, Program, and Boot files. 

CAUTION: The Versions command will restart the RTU. 
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4.3 Special Notes on RTU Files  

Planning is paramount to efficient and effective RTU configurations. In systems that use 
multiple RTUs, users should categorize RTUs by the clients and servers that will be used on 
them. Then, for each category, create generic RTU files that contain the maximum amounts 
of sized data points to accommodate all possible scenarios. Later, when the generic RTU file 
for a category is used, the points can be filtered to suit the needs of that particular RTU 
configuration.  

The following points should be considered: 

• Does the SCADA system have numerous RTUs that can be categorized? 
If there are many RTUs with differing needs, categorize the RTUs by needs, by size, or 
by client/server arrangements. 

• Do the categories need to be divided into sub-classes of generic RTUs? 
Sub-divide the categories of RTUs into generic classes to fit ranges of parameters. 

• What are the parameters for each of the generic RTUs in each category? 
Assign ranges of parameters for each sub-classified generic RTU. 

• Is the use of the Programmable Logic and Communication Control (PLCC) client 
planned? If so, read PLCC manual for more information. 

For example, users should create a generic RTU file for each category that represents the 
RTUs used in their system. One category of RTU file might contain two servers of a certain 
type and 20 clients of the same particular type. Another category of RTU file may contain one 
server of a certain type, three clients of a particular type, and three more clients of another 
particular type. Each of the clients in the generic RTU file by category should be sized for the 
most available data points. When the RTU file is used specifically, the data points for each 
client can be filtered for that specific RTU.  
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Creating generic RTU files by category, duplicating them and then configuring them 
specifically for each different RTU is much more efficient than configuring a new RTU file for 
every RTU in the system. Using the example given above, apply the generic RTU files to 
specific RTU needs. For example, assume that there are 15 RTUs in the system that need to 
be configured. Use the generic RTUs in the example given and apply the best-suited generic 
RTU file for each particular RTU.  

First, group the RTUs into the categories according to their general needs. (Needs may be 
defined as the necessary amount of clients, servers, and points available for mapping.) This 
implies that the clients should be sized with a liberal estimate of the highest amount of data 
points needed by any client in that type of RTU. See the image, below. 
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After categorizing the RTUs, classify them according to more specific criteria. For example, 
RTU # 8 in this scenario needs to be configured with two clients of each type and 110 data 
points. Because the “Generic RTU #3” file most closely matches the needs of RTU #8, it is 
the clear choice.  

 
 

The above illustrates how to match the rest of the 14 RTUs to the closest generic RTU file. By 
producing the specific RTU files from the generic, time is saved because all possible system 
scenarios are available as a template in at least one of the categories. Future RTUs may 
need a new generic RTU file created for them because they are larger or have special 
parameters not met by any of the files available, but it is always easier to work from the 
generic to the specific. 
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4.4 Next Steps 

Now that an RTU file is open, it is possible to begin adding and configuring field device clients 
and master station servers. The sequence should follow this pattern: 

• Add field device clients and master station servers. 

• Add components (Eports, NetConfig, etc). 

• Modify properties for field device clients. 

• Modify properties for master station servers. 

• Modify properties for components. 

• Filter data points for field device clients, adding names and descriptions if desired. 

• Map data points to master station servers. 

• Configure the serial communication ports.  If Eports are present, it is more convenient 
to configure the Eports before the Ports. 

• Configure the RTU. 

 

NOTE: The screenshot display figures shown in this manual are typical for the template used 
to configure 6CPP6 processor board RTUs. The displays for the 6ACP5 processor 
board template are different in many instances. 
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5 Adding RTU Components 

RTU components can be added from the New pull-down menu.  These components, which 
together comprise the RTU, include master station servers, field device clients, and 
communication components (Eports, NetConfig, Portswitch, etc).  These items can be added 

by selecting New Master Station, New Field Device (IED), or New Component from the 
pull-down menu and can be added in any order. 

 

NOTE: Selecting New RTU deletes the present configuration. Only select New RTU to erase 
the present configuration and begin a new configuration. 
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5.1 Adding a Master Station Server 

To add a master station server: 

1. From the New pull-down menu, select New Master Station. 

2. Add a master station server in one of the following ways: 

• Select a master station server type in the Name column and select the Add 
button. 

• Double click on a master station server type in the Name column. 

 

Note:  Do not select or double click from the Driver column. 

 

 

Name Displays the name of the available master station servers.  

Driver Displays the server name.  

Max Displays the maximum amount for each driver type.  

 

The maximum number of master station servers is five per RTU.  If an attempt is made to add 
more than the maximum number of master station servers or too many of the same type, an 
error message is displayed. 
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TIP: The circled areas in the illustration below show that by moving the cursor between the 
column labels at the top of the window, and then clicking, holding, dragging, and 
releasing the mouse button, it is possible to stretch or shrink the displayed field areas. 
This technique can be used to manipulate similar  windows in ConfigWiz. 

 

 
 

5.2 Removing a Master Station Server 

If a master station server is removed, all mapping information and the server configuration will 
be lost.  To remove a master station server: 

1. Position the cursor over the icon of the master station server to be removed. 

2. Right-click on the icon to display the pull-down menu. 

3. Select Remove from the list of commands. 

4. Select Yes on the conformation window, if the master station server should be 

removed; No cancels the remove operation. 

Alternately, select Components->Master Stations from the main menu.  Select the Master 

Station server that you wish to delete, then select the Remove button. 

5.3 Server Review 
• To add master station servers, select New Master Station from the New pull-down 

menu. 

• Master station servers can be added in any order.  When a master station server is 

added, an icon appears in the ConfigWiz window. 

• Limits on the number of master station servers are controlled automatically and 
cannot be overridden. 

• Master station servers can be removed by right-clicking on the icon and selecting 

Remove from the pull-down menu, or, from the Components->Master Stations 
window. 
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5.4 Adding a Field Device Client 

To add a field device client: 

1. From the New pull-down menu, select New Field Device (IED).  The Add Field 
Device (IED) window is displayed. 

2. Add a field device client in one of the following ways: 

• Select a field device client from the Name column, select the Add button 

• Select a field device client from the Name column, select the displayed value in 

the How many to add? box with your cursor, type a new value over the old 

value, select the Add button 

• Select a field device client from the Name column, use the increase/decrease 

buttons next to the How many to add? box, select the Add button. 

• Double-click on a field device client from the Name column 

 

A Sizing window may be displayed for clients requiring sizing.  Enter new values or 

accept the default values by selecting OK.  Refer to Sizing a Field Device Client for 
more information. 

 

 

Name Displays the name of the field device type. The name of the device can be 

changed by right-clicking on the device icon in the ConfigWiz window. 

Driver Displays the name of the field device driver type.  

Max Displays the maximum number of IEDs for that device type that can be added to 
the RTU configuration file. 

 

 

TIP: When adding multiple field device clients of the same type, it is recommended to 
change the default data point names and descriptions to custom names and 
descriptions (see section 7.1 IED filtering display). The custom names should 
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describe the information that the data point transmits. The field device client can then 
be duplicated to create similar field device clients. 

 

NOTE: The order that the field device clients are added determines the order that they 

appear in the data point list. However, ConfigWiz groups devices belonging to the 
same client, regardless of selection order. This is critical when adding field device 
clients to an existing RTU file because of the possible complications it can have on 
master station server mapping. 

There is no maximum number of field device clients that can be added to Configwiz. A scroll 

bar will appear in the ConfigWiz window if the number of field device clients exceeds the 

number that can be displayed.  The ConfigWiz window can be resized to allow more (or less) 
field device clients to be displayed. 
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5.5 Removing a Field Device Client 

If a field device client is removed, all configuration (filtering and mapping) will be lost.  To 
remove a field device client: 

1. Position the cursor over the icon of the field device client to be removed. 

2. Right-click on the icon to display the pull-down menu. 

3. Select Remove from the list of commands. 

4. Select Yes on the conformation window, if the field device client should be removed; 

No cancels the remove operation. 

Alternately, select Components->Field Devices (IEDs) from the main menu.  Select the IED 

that you wish to delete, then select the Remove button. 

 

5.6 Client Review 
• To add field device clients, select New Field Device (IED) from the New pull-down 

menu. 

• Field device clients can be added in any order.  When a field device client is added, 

an icon appears in the ConfigWiz window. 

• Some field device clients may be sized and then re-sized. 

• Limits on the number of field device clients are controlled automatically and cannot be 
overridden. 

• Field device clients can be removed by right-clicking on the icon and selecting 

Remove from the pull-down menu, or, from the Components->Field Devices (IEDs) 
window. 
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5.7 Sizing a Field Device Client  

Some field device clients place a device icon directly on the ConfigWiz window while other 

field device clients prompt a Sizing window. The Sizing window enables the user to increase 
or decrease the amount of available data points in the fields listed below:  

• Analogs 

• Status 

• Accums 

• Controls 

• Setpoints 

NOTE: Some point types may not be supported by some clients and should be set to zero. 
The number of data points that are available to the master station server can be 
modified after sizing, by using point filtering. Refer to Filtering Data Points that Map to 
the Master Station for more information.  It is important to select the pre-determined 
number of data points before any master station server mapping is done to avoid 
doing manual master station server mapping. 

To size a field device client: 

1. In the Sizing window, determine if the default values need to be changed.  

 

2. If no changes need to be made, select OK. 

NOTE: Selecting Cancel enters the default values or values entered by the user in 
the Sizing window. 

3. If changes are needed, select the value displayed in any of the data point fields and 
enter new values. 

4. Select OK when finished.  A field device client icon is added to the ConfigWiz 
window. 
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5.8 Modify Field Device Client Size 

Modifications to the size of field device clients should be performed before data point filtering 
or mapping is done.  To resize a field device client: 

1. Position the cursor over the icon of the field device client to be resized. 

2. Right-click on the icon to display the pull-down menu. 

3. Select Resize from the list of commands.  The Resizing window appears. 

4. Select and modify the data fields as needed.  

5. Select OK to enter modifications, or select Cancel to cancel modifications. 

 

5.9 Sizing Review 
• Sizing is not a required step for all field device clients. The Sizing window only 

displays when a field device client is added that allows sizing. 

• Sizing enables the user to increase or decrease the number of data points available 
for mapping to the master station. 

• Sizing can be readjusted by right-clicking on a field device client icon and selecting 

Resize from the pull-down menu. 



 Configwiz User Guide        UM-2012  

Copyright © 2019 QEI, LLC Modify Properties  •  33 

5.10 Modify Properties  

The properties of master station servers or field device clients can be modified from the 

Properties window.  To display this window, click on a master station server or field device 

client icon in the main ConfigWiz window.  Select the desired tab and enter the properties 
into the fields provided.  

 

Each master station server or field device client has its own unique set of properties.  Some 
properties have multiple values and are displayed as multiple rows.  For these properties, 
buttons are provided to help configure the rows.  The buttons displayed depend on the 
property’s data type.  The buttons have the following functionality: 

• Fill With Names – Fill the rows with the Point Names from the appropriate point type. 

• Fill With Desc – Fill the rows with the Descriptions from the appropriate point type 

• Fill With Values – Fill the rows with the value found in the entry box or the pull-down 
menu located directly below the button. 

• Clear All Entries – Blank out all rows. 

• Default All Entries – Fill the rows with the property’s default value. 

• Previous Values – Restore the values that were configured when the tab was last 
selected. 

 

5.10.1 Special Input 
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 Some fields require the entry of numbers and some require characters. Numeric fields can 
accept the decimal or hex form of a number, but some fields display a hex number by default 
where hex entries are easier. Use the ampersand sign (&) followed by the letter “h” to indicate 
that a hexadecimal number follows. 

 

 

TIP: Enter hex numbers with care, ConfigWiz validates decimal numbers but not hex 
numbers entered in fields. 
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6 Configuring Communications Components 

Communication components are provided so that the rtu can communicate with the master 
station and field devices.  The main communication components are the serial communication 
ports.  Other communication components include Eports, NetConfig, Security, Terminal 
Servers and Port Switches. 

6.1 Configuring Serial Communication Ports 

Serial communication ports must be configured for user, speed, and connection type. The 
configuration information must be prepared prior to rtu configuration and should be available 
during the port configuration process.   

To configure the serial communication ports, do the following: 

1. Select Ports from the Components pull-down menu.  The Port Configuration window is 
displayed. 

 

2. Make changes as required.  Modified fields are highlighted in yellow.  If an entry is invalid, 
an error message is issued and the field is returned to its last valid value. 

3. The User picklist consists of clients and servers that are presently configured in the RTU 
and that are permitted on a particular port.  For example, NBit type clients are only 
permitted on Ports 1-5; only Quics clients and servers are allowed on Port 10 and Port 11.  
Free indicates that the port is not being used. 

4. Select the Apply button to save the changes.  If changes are made and not saved, a 

warning message is issued when trying to exit the window.  The Restore button can be 
used to restore the fields to the last saved values. 
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5. When the Apply button is selected, ConfigWiz makes an overall check of the Port and 

Eport configuration.  If there are any errors, the values are not saved and the user of the 
port with the invalid configuration is highlighted in red.  If there are no errors, the values 
are saved and all fields are displayed in white.  After successfully applying the changes, 
ConfigWiz may issue a warning message.  These warnings should be cleared before the 
rtu file is saved. 

6. After successfully applying the changes, ConfigWiz will change the port property of the 
IEDs to reflect the saved port configuration.  The user does not have to configure the 
IEDs to match the port configuration. 

7. If a field device client has multiple IEDs, a Cfg IEDs button is displayed under the first 
port the client is assigned to (clients can be assigned to multiple ports).  Select the button 

to display the Configure IEDs  window. 

 

 

8. Configure the IEDs by providing each IED with an address and assigning each IED to a 
port.  The address must be unique for each port.  In the above example, Port 2 has IEDs 
assigned to addresses 0, 1, and 2, and Port 4 also has IEDs assigned to addresses 0, 1, 
and 2.  The IEDs can be assigned to any port in any order as long as the IED has a 
unique address on that port.  In addition, there must be at least one IED assigned to each 
port. 

9. If an IED is assigned to an Eport, the IED is grayed out.  The remaining IEDs must be 
configured as described above. 
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6.1.1 Parameters for Ports 1 – 9 

 

Field Name Description Valid Entries 

User Displays the name of the port user. Select one as 
required from the list of choices. 

List of clients/servers that 
are presently configured  
and permitted on the port 

BaudRate Displays the selected baud rate. Select one as 
required from the list of choices. 

150, 300, 600, 1200, 
2400, 4800, 9600, 

19200, 38400, 57600 

Parity Displays the Bits/Parity option. Select one as required 
from the list of choices. 

8/No, 8/Odd, 8/Even, 
7/No, 7/Odd, 7/Even 

RtsCtsDelay Displays the delay in milliseconds from Request To 

Send to transmitting data when Clear To Send (cts) 

is not available.  Enter required delay. If Push to Talk 
is enabled, an appropriate delay is required. 

0 -65535 

RtsHoldTime Displays the time to hold the Request To Send (rts) 
after transmission.  Enter required delay.  

0 - 65535 

InterCharTime Displays the Inter-character Timeout value in 

milliseconds. InterCharTime is the maximum delay 
between two characters in a message. Enter required 
delay.  

0 - 65535 

Timeout Displays IEDs or field devices poll response time-out 
for Client ports only. Enter value in milliseconds. 

0 – 8388607 

 

PushToTalk Displays the Push to Talk option. On radio systems, 

the Push To Talk signal will key the radio during 

transmission. Select Yes, if Push to Talk is required.  

No / Yes 

EnableDCD Displays the Enable external Data Carrier Detect. 

EnableDCD provides data guard or ignores DCD. 

Select Yes to receive data only after DCD is received.  

No / Yes 

EnableCts Displays Enable external Clear To Send that 
controls data transmission or ignore CTS and 

DataDelay. Select Yes, to transmit data after CTS is 
received. Set RtsCtsDelay to zero. 

No / Yes 

 

NOTE: When the ports are used by the QUICS server with the 3000 protocol option, the 
BaudRate, Parity, and InterCharTime parameters are ignored. The LAP5 optional 
board is required to support the 3000 protocol. 

NOTE: Not all ports may be available in your 6ACP5 or  6CPP6 processor board. Refer to the  
6ACP5 or 6CPP6 processor board documentation for ports available 
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 6.1.2 Parameters for Ports 10 and 11 

 

Field Name Description Valid Entries 

User Displays the name of the port user. 

 The TM1 is used by a QUICS server. The second 
QUICS server uses the TM 2, if required. 

List of QUICs 
clients/servers that are 
presently configured 

BaudRate This field will be ignored for systems with a 6TM2.  

Set to 150. 

150, 300, 600, 1200, 
2400, 4800, 9600, 

19200, 38400, 57600 

Parity Not applicable, entries are ignored. 8/No, 8/Odd, 8/Even, 
7/No, 7/Odd, 7/Even 

RtsCtsDelay If Push to Talk is not selected ‘Yes’, any entry is 

ignored.  If Push to Talk is selected ‘Yes’, then enter 
an appropriate delay. 

0 -65535 

RtsHoldTime Not applicable, entries are ignored. 0 - 65535 

InterCharTime Not applicable, entries are ignored. 0 - 65535 

Timeout Not applicable, entries are ignored. 0 – 8388607 

PushToTalk Displays the Push to Talk option. On radio systems, 

the Push To Talk signal will key the radio during 

transmission. Select Yes, if Push to Talk is required.   

Refer to the 6TM2 documentation to determine proper 

setting for Push to Talk.   

No / Yes 

EnableDCD Not applicable, entries are ignored. No / Yes 

EnableCts Not applicable, entries are ignored.  No / Yes 
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6.1.3 Parameters for Port 12 

 

Field Name Description Valid Entries 

User Displays the name of the port user. 

For servers with dial-up capability, the physical port in 
the 6ACP5 or 6CPP6 processor board that is 
communicating with the master is assigned the Dialup 
port as the user. 

List of clients/servers that 
are presently configured  
and permitted on the port 

BaudRate Displays the selected baud rate. 150, 300, 600, 1200, 
2400, 4800, 9600, 

19200, 38400, 57600 

Parity Displays the Bits/Parity option. 8/No, 8/Odd, 8/Even, 
7/No, 7/Odd, 7/Even 

RtsCtsDelay Displays the delay in milliseconds from Request To 

Send to transmitting data when Clear To Send (cts) 
is not available. 

0 -65535 

RtsHoldTime Displays the time to hold the Request To Send (rts) 
after transmission. 

0 - 65535 

InterCharTime Displays the Inter-character Timeout value in 

milliseconds. InterCharTime is the maximum delay 
between two characters in a message. 

0 - 65535 

Timeout Not applicable, entries are ignored. 0 – 8388607 

PushToTalk Not applicable, entries are ignored.  No / Yes 

EnableDCD Displays the Enable external Data Carrier Detect. 

EnableDCD provides data guard or ignores DCD. 

Select Yes to receive data only after DCD is received.  

No / Yes 

EnableCts Displays Enable external Clear To Send that 
controls data transmission or ignore CTS and 

DataDelay. Select Yes, to transmit data after CTS is 
received. Set RtsCts delay to zero. 

No / Yes 
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6.2 Configuring EPorts 

The Eports (Ethernet Ports) component provides specific port settings for each required 
Ethernet port. This component provides the following: 

• Assigns a master station server or a field device client to each EPort. 

• Assigns each EPort as either a client or server. 

• Assigns an IP address and a TCP/IP port to each EPort. 

• Assigns a transport protocol and protection setting for each EPort. 

 

The EPort Configuration window operates the same way as the Port Configuration 
window: 

- Select Components from the Components pull-down menu.  Select Eports from the list 

of components.  Alternately, click on the Eports label at the bottom of the ConfigWiz 
window. 

- Modified fields are highlighted in yellow, invalid entries are rejected and returned to the 
last valid value. 

- The User picklist consists of clients and servers that are presently configured in the RTU 
and that can communicate through an EPort. 

- The Apply button saves the changes; the Restore button restores the last saved values.  
A warning is issued if values are not saved before exiting. 

- There is an overall check of the Port and Eport configuration when the Apply button is 
selected.  If there are errors, the values are not saved and the users with the invalid 
configuration are highlighted in red.  Warnings may be issued after a successful save. 

-  The Port and Eport properties of client IEDs will be changed to reflect a successfully 
saved EPort configuration. 
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- A Cfg IEDs button is displayed if a client has multiple IEDs.  If an IED is initially placed on 
a Port or subsequently moved from an Eport to a Port, the IED must be assigned to a 

specific Port in the Port Configuration window.  If an IED is moved from a Port to an 

Eport, IED assignments may have to be adjusted in the Port Configuration window. 

- The NetConfig component is required for the Eport component. If not in the present 
configuration, the NetConfig component is automatically added when the Eports 
component is added.  

- The number of Eports displayed can be set from the File->User Preferences window. 

 

For specific information on EPort configuration, refer to the EPort Component addendum. 

 

6.3 Configuring NetConfig 

The NetConfig Component in ConfigWiz provides basic network configuration parameters for 
the 6NIA Network Interface Adapter.  Specifically, this component is used to specify platform-
wide addressing parameters for the network(s) that the 6NIA is connected to.   

The NetConfig Component is designed to support redundant communications over multiple 
media channels, with automatic failover capabilities in the event that the primary channel fails.  
It also performs the following functions: 

• Assigns IP addresses, netmasks, and routing parameters for all network devices. 

• Assigns supplemental network parameters used in support of the failover capabilities. 

• Implements connection testing for all active components. 

• Re-routes connections in the case of failure, and routes them back when the first 
connection is restored. 

 

For specific information on NetConfig, refer to the NetConfig Component addendum. 

 

6.4 Configuring Security 

The Security component gives the ability to set, modify and remove usernames and 
passwords to restrict access to configuring and troubleshooting the 6CPP6 based RTU.   

Each username/password combination can be set to control access to the 6CPP6 Test Panel, 
the Web Server or to a Terminal Server. 

For more information on specific configuration requirements, refer to the Security/Users 
Component addendum.  In addition, usage information when logging into the 6CPP6 Test 
Panel can be found in TP-803, 6CPP6 Test Panel Instruction Manual. 
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6.5 Configuring Terminal Servers 

The Terminal Server component simply connects two communication ports together, so that 
traffic coming in on one port goes out the other, and vice-versa.  It is frequently used to 
provide network access to an IED’s diagnostic port for IED configuration or status monitor, but 
can also be used to bridge between an external network and an internal one (and optionally 
adding encryption and/or authentication), or to connect two serial ports together to do baud 
rate conversion, RS-232 to RS-485 conversion or modem control.  There are three Terminal 
Servers labeled TermSrvr1, TermSrvr2, and TermSrvr3. 

For more information, refer to the Terminal Server Component addendum. 

 

6.6 Configuring Port Switches 

The PortSwitch component allows any byte oriented server to function as a redundant server 
without having to setup two different master stations to two different ports. A PortSwitch 
handles the connection between a primary and alternate communication line and a single 
Master Station server. 

A PortSwitch will function only on byte oriented servers, and will multiplex both IP based and 
serial based communications lines. For example, a system may have a primary IP 
communication line and a serial based alternate communication line to the RTU’s. A 
PortSwitch will allow either line to communicate with the master station server at any time, 
without resending data when the line switches from primary to alternate, or vice-versa. 

There are two PortSwitch components, labeled PortSwitch and Portswitch2, allowing two 
Master Stations to run in redundant mode. 

For more information, refer to the Port Switch addendum. 
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7 Configuring Clients 

7.1 IED Point Filtering Display 

The purpose of field device data point filtering and master station data point mapping is to 
reduce the communications load. The field device client is sized to accommodate all the data 
points in the device although not all of the points will be used by a master station.  After the 

field device client is sized, data points that are not being used are filtered out using the IED 

Point Filtering display.   

The filtering display enables the user to select data points that are available to one or more 
master station servers.  There are five checkboxes that are used to display the page for each 
point type.  All data points (for the selected point type) are displayed in the right-hand pane, 
points available for mapping (filtered points) are displayed in the left-hand pane.  The total 
number of data points is displayed above the right hand pane, the number of filtered points is 
displayed above the left hand pane.  To filter or unfilter a point, simply click on the filter 
column located in the right hand pane. 

NOTE: The term IED used in the IED Point Filtering display refers to field devices also. 
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7.2 Filtering Data Points for a Field Device Client 

The IED Point Filtering display can be accessed in one of two ways: 

1. Click on a field device client icon on the ConfigWiz window.  The Properties window 

is displayed.  Select the Filtering button.  The IED Point Filtering window is 
displayed. 

2. Right click on a field device client icon on the ConfigWiz window.  Select Filtering 

from the menu list.  The IED point filtering window is displayed. 

Select a point type and filter/unfilter the data points as described above. 

 

7.3 Point Name and Description Fields 

The point name (PtName) and description (Desc) fields are used to identify the data points.  
These fields are also used by QEI Automation ’s Plus Editors RTU import feature to configure 
scada points on the Master station; PtName is used to configure the scada point’s Point 
Name field, Desc is used to configure the scada point’s Description field. 

The PtName and Desc fields can be edited by selecting the field and typing in the cell.  Either 
pane can be used, the edited field is immediately copied to the other side.  The enter and/or 
tab keys can be used to navigate between cells. 

The PtName field cannot be duplicated for any point in the entire field device client.  For 
example, a status point cannot have the same PtName as an analog point.  Duplicate 
PtName fields are displayed in red and must be corrected before changing the page or exiting 
the display. 

There is one exception to this rule.  A control point can be associated with a status point in the 
master station (same master station point name, different telemetry input, open, and close 
addresses) by giving the control and status point the same PtName.  Associated control and 
status points are displayed in green.  Note that two control points or two status points cannot 
have the same PtName, only unique control and status point pairs. 

The length of the PtName and Desc fields is determined by the Enforce QEI Automation  
Naming option from the User Preferences display (select User Preference from the main file 
menu).  If QEI Automation naming is enforced, the PtName fields is limited to 6 characters 
and the Desc file is limited to 24 characters.  If QEI Automation naming is not enforced, both 
fields can be up to 48 characters in length. 

 

7.4 Importing or Exporting Point Name and Description Fields 

Point names and descriptions can be imported or exported to an excel spread sheet.  This 
feature can be used to speed up configuration of these fields. 

The fields can be imported to or exported from the right-hand pane (all points) or the left hand 

pane (filtered points).  This is done by selecting the XL Imp/Exp button under the desired 
pane.  In addition, the fields can be imported to or exported from the currently selected point 
type or all point types in the field device client.  The is done by selecting one of the four 
checkboxes in the popup window as show below: 
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For all options, the excel workbook path and name can be typed in or selected using the 

browse button (…).  For the Import Page option, the sheet name is displayed as a pull-down 

which lists all of the sheets in the specified workbook.  For the Export Page option, any sheet 

name can be used.  For the Import All or Export All options, fixed sheet names (Analogs, 
Status, Accums, Controls, Setpoints) are used. 
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 An example of an exported excel spread sheet follows: 

 

Note the PtNames and Desc keywords in row 1.  These keywords are used to identify the 
columns. 

For import, the following applies: 

• Point names and descriptions can be imported separately or together.  In the 
spreadsheet, the fields can be placed in any column and in any order as long as the 
PtNames and/or Desc keywords are used in row 1 to identify the fields. 

• Blank rows are allowed. 

• The existing PtNames and/or Desc fields on the filtering display are blanked out 
before the import. 

• Warning messages are given if the number of rows in the spreadsheet do not match 
the number of rows in the pane being imported to.  Excess rows are discarded. 

• For the Import Page option, duplicate PtNames are flagged in red. The user is not 
allowed to change the page or exit the display until the errors are corrected.  For the 

Import All option, duplicate PtNames are replaced with *err*.  The user can exit the 
display if desired, however, the points flagged with *err* will be ignored when 
importing into Plus Editors. 
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7.5 Buttons on the IED Point Filtering Display 

The buttons on the IED Point Filtering Display have the following functionality.  Note that the 
action only applies to the page currently being displayed 

• Remove All – unfilter all points 

• Add All – filters all points 

• XL Imp/Exp – displays the excel import/export window for the pane above the button. 

• Clear Desc – blanks out all Desc fields 

• Clear Names – blanks out all PtName fields 

• Auto Name – configures the PtName field.  The format is a single character 
representing the point type, followed by two numbers representing the IED number, 
followed by three numbers representing the point’s internal id number.  For 
accumulators, the format is M, followed by a single character representing the IED 
number, followed by two numbers representing the id number.  An error message is 
displayed if the IED or id numbers cannot be represented by the auto-naming format. 

• Restore – restores the PtName, Desc, and Filter fields to the state they were in when 
the page was last entered.  For example, if changes were made on the analog page, 
then changes were made on the status page, then additional changes were made on 
the analog page, selecting the restore button (on the analog page) would restore the 
analog points to the state they were in after the first set of changes. 

 

7.6 IED Filtering Review  
• The IED Point Filtering display allows a user to make field device client data points 

available to one or more master station servers. 

• The right hand pane shows all data points in the field device client.  The left hand 
pane shows filtered data points. 

• The Point Name and Description fields are used when creating master station 
SCADA points  

• Point Names and Descriptions can be imported from or exported to an Excel spread 
sheet. 
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8 Configuring Servers  

8.1 RTU to Master Station Mapping Display 

Data points that are available for mapping can be mapped to a master station server from the 

RTU to Master Station Point Mapping window.  The data points are made available from 

the IED Point Filtering window. 

The mapping window has five tabs, one for each point type.  The right hand pane displays all 
of the points that are available for mapping from all of the field device clients.  The left hand 
pane displays the points that are actually mapped to the master station server.  

8.2 Mapping Data Points to a Master Station Server 

Mapping data points differs from filtering data points.  When filtering, the user just selects the 

data point to filter by clicking on the filtering column on the IED Point Filtering window.  
When mapping, the user must select the points to map and place the points in a particular 
position in the master station server.  This is done by either dragging and dropping points 
from the right hand pane to the left hand pane or by using the auto mapping feature . 

The mapping display can be accessed in one of two ways: 

1. Click on a master station server icon in the ConfigWiz window.  The Properties 

window is displayed.  Select the Mapping button.  The RTU to Master Station Point 

Mapping window is displayed. 

2. Right click on a master station server icon on the ConfigWiz window.  Select 

Mapping from the menu list.  The RTU to Master Station Point Mapping window is 
displayed. 
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Initially, the master station server must be sized, then, points must be mapped.  This can be 

done in two ways, by selecting the Automap button which sizes and maps the points at the 

same time, or by selecting the Size button and mapping the points afterward. 

If Automap is selected, the Master Station Point Sizing for Automapping window displays. 

 
Select Use All to size the master station server for all available data points, or type in the 
size for each point type. 

Select Size and Map. The master station server is sized and all of the available data 
points are mapped.  If there is not enough room to hold all of the available data points, the 
points are left unmapped. 
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NOTE: If Automap is selected after sizing, the sizing and mapping data is lost.  If so, a 
warning message is displayed.  Once an RTU file has been created, data points 
should be mapped manually or previous work will be lost. 

 

 

If Size is selected, the Master Station Point Sizing window displays. 

 

 

Select Use All to size the master station server for all available data points, or type in the 
size for each point type. 

Select Size to size the master station server. Sizing creates slots for the data points. All 
the slots do not have to be filled and they do not need to be filled in sequence. 
Select one of the five tabs on the mapping display. 
Select a data point from the right hand pane and drag and drop it to a position in the left 
hand pane.  Multiple points can be selected by pressing the ctrl key and clicking on each 
point. 
Mapped points in the left hand pane can be repositioned by dragging and dropping the 
point from one slot to another. 
Mapped points can be unmapped by selecting one or more points in the left hand pane 

and then selecting the Unmap button.  Also, points can be unmapped by selecting one or 
more points in the left hand pane and dragging them to any spot in the right hand pane.  

In addition, all points can be unmapped by selecting the Unmap All button. 
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8.3 Mapping Review 

Data points that are available for mapping (filtered data points) can be mapped to a master 

station server from the RTU to Master Station Point Mapping display.  The data points are 

made available from the IED Point Filtering display. 

The master station server must be sized and data points must be mapped.  This can be done 

separately or in one step using the Automap button. 

If the Automap button is used, previous size and mapping information is lost. 

Data points can be manually mapped by selecting one or more points from the right hand 
pane and dragging and dropping them to a slot in the left hand pane. 

Mapped data points can be repositioned by dragging and dropping them from one slot to 
another. 

Mapped data points can be unmapped by selecting one or more points from the left hand 

pane and selecting the Unmap key or dragging and dropping the points to any position in the 

right hand pane.  All mapped data points can be unmapped by selecting the Unmap All 
button. 
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9 Configuring the RTU  

9.1 About This Section 

After configuring the master station servers, field device clients, and communication 
components, the RTU must be configured. 

1. Select RTU from the Components pull-down menu.  The Properties window for the 

RTU is displayed. The window contains the QBUS and RTU tabs. Use both of these 
tabs to complete the configuration of the RTU. 

 

NOTE:  The QBUS tab is needed only in systems with QUICS cards. 
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Field 

Name 

 

Description 

Selectable 

Entries 

Valid 

Entries 

Default 

Values 

QcardType Displays the QUICS card type. 
Select the QUICS card type for 
each slot as required or leave 

the default (0 - Empty Slot), if 
QUICS cards are not required.  
The RTU only supports slots 
1-16.  

The 6DA, 6SP, 6DO are 
associated with the Local 
Client. The 6AD, 6SI and 6CM 
are associated with the 7BI 
client. The 6TM may be 
associated with QUICS 
servers. 

0 - Empty Slot; 
1 - 6DA Analog Output, 
2 - 6DO Digital Output, 
3 - 6SP Set Point, 
4 - 6TM QUICS Modem, 
5 – Future, 
6 – Future, 
7 – Future, 
8 - 6SI Status Input, 
9 - 6AD A/D, 
10 - 6CM Control Matrix 

Picklist 0 – Empty 
Slot 

 

2. Select values in the fields displayed in the pull-down menus in each field according to 
the configuration plan.  To activate the pull-down menu for each field click in the field 
once, then click on the pull-down menu and select from the menu. 

 

 
 

When the selection process is complete for the QBUS tab, select the RTU tab. The RTU 
tab displays three fields for assigning a descriptive name to the RTU, and configuring the 
time synchronization parameters for the RTU. 
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9.2 RTU Tab 

 

 
 

Field 

Name 

 

Description 

Selectable 

Entries 

Valid 

Entries 

Default 

Values 

Description Displays a custom, descriptive name of the 
RTU configuration, if given. Enter optional 
description of the RTU set-up (100 characters 
maximum) or leave blank. 

   

TimeSynch Displays the server that the RTU uses for time 
synchronization. Select the Server for 
synchronization of the RTU from the list of 
choices (QUICS, DNP3, UCA,……...). 

List of 
available 
servers 

Picklist QUIC_S#
1 

SynchInterval Displays the synchronization interval specified 
for the RTU. The RTU will send a time 
synchronization failure to the master station, if 
the interval of the last time synchronization 
received was greater than the specified 

SynchInterval in seconds.  

 0 - 65535 1200 

 

After entering the information in the Options tabs, the user may save the RTU file to disk 
and/or write the RTU to the Platform from the File pull-down menu. 
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10 Configuration Tools 

10.1 About This Section 

The Tools menu provides utilities for communicating with an RTU over Ethernet, and tools for 
creating and working with IEDs. 

10.2 Tunnel Config 

ConfigWiz can read and write configuration files to and from an RTU over an Ethernet 
connection via the 6NIA1 (Network Interface Adapter).  In order to provide a measure of 
security, the connection employs STunnel and SSL.  STunnel and SSL are provided with the 
ConfigWiz installation. 

To enable Ethernet communications, an entry for the RTU must be made in the Tunnel Editor 
(Tools->Tunnel Config).  The entries are stored in a file named stunnel.conf, which is stored in 
the \security folder. 

A tunnel definition consists of a hostname and socket pair.  The socket pair is the RTU IP 
address and port and the Local IP address and port.  The Local IP address is not displayed, 
as it is defined as the localhost. 

 

Tunnel Editor 

When the Tunnel Editor is displayed for the first time, it is blank. 
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To enter a new tunnel, select the New button.  The New Tunnel window appears: 

 

 

Field 

Name 

 

Description 

Selectable 

Entries 

Valid Entries Default 

Values 

Tunnel 

Name 

Tunnel Name is the identifier for the 
tunnel. 

None Same name as 
NetConfig host 

name 

None 

IP Address This is the actual IP address of the 
RTU. 

None. IP address in the 
form 

aaa.bbb.ccc.ddd.
Ex. 

192.168.101.6 

None 

Port  This is the actual port on the RTU.  0 - 65535 57222 

Local Port The Local Port is the port on the client 
end of the tunnel.  ConfigWiz will 
automatically generate the Local port, 
but this can be selected by the user. 

None 0 - 65535 40000 

 

 

When the entry is complete, select Add to add the new tunnel and return to the editor.  Select 

Cancel to exit, without adding the new tunnel. 

The newly defined tunnel will appear in the Tunnel Editor window.  You must select the Save 
button for the new tunnel to saved in the tunnel configuration file. 
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• The Edit button is used to change the IP Address or Port, it does not allow changing 
the Tunnel Name. 

• The Delete button is used to completely delete an entry. To change the Tunnel 

Name, use the Delete then New buttons. 

• The Save button updates the stunnel.conf file.  The previous stunnel.conf (if it 

existed) is then saved as stunnel.bak.  The Save button also starts the STunnel 
program if it is not already running. 

• The Exit button exits the tunnel editor without saving the changes to stunnel.conf 

 

10.3 Start stunnel / Kill stunnel 

These menu items starts and stops the STunnel program.  The STunnel program is also 

started when the Save button is selected on the tunnel editor.  An icon is displayed in the icon 
tray when the STunnel program is running. 
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10.4 Run UCA Config 

This menu item runs the GOMSFE Model Editor which is used to create UCA IEDs.  The 
created IEDs are stored in the \UCA folder and can be added to the RTU configuration 

through the ADD Field Device (IED) window ( New->New Field Device (IED) ). 

 

Refer to the UCA 2.0 Client addendum for detailed information on how to create UCA IEDs.   
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10.5 Make SEL IED 

This menu item displays the Make SEL IED window which is used to create IEDs from SEL 
devices. The created IEDs are stored in the \SEL folder and can be added to the RTU 

configuration through the ADD Field Device (IED) window  (New->New Field Device (IED) ). 

 

There are several ways to connect the user’s PC to the SEL device: 

(a)  Thru an RTU.  The PC’s serial port is connected to the test port of the RTU, one of 
the RTU’s ports is connected to the F port of the SEL device. 

(b) Directly to the SEL device.  The PC’s serial port is connected directly to the F port of 
the SEL device using a NULL modem converter. 

(c) Thru an RTU connected to a 2020 SEL device.  The PC’s serial port is connected to 
the test port of the RTU, one of the RTU’s ports is connected to a 2020 device, one of 
the 2020 device’s ports is connected to the SEL device. 

(d) Directly to the 2020 SEL device.  The PC’s serial port is connected directly to the 
2020 device, one of the 2020 device’s ports is connected to the SEL device. 

To create a SEL IED, select the Make SEL button.  Messages are displayed detailing the 
procedure’s progress.  When completed, the created IED file is named 
\SEL\seldevicename.ied. 

There are several intermediate files created during the SEL extraction process.  Normally, 
these files are deleted.  However, these files can be retained for debugging purposes by 

checking the Keep Intermediate Files checkbox.  The intermediate files are saved in the 
\SEL folder. 



Configwiz User Guide        UM-2012 

 

60  • Make SEL IED Copyright © 2019 QEI, LLC  

 The input fields are: 

SEL Device Name: The name given to the created .ied file. 

SEL Password: The level 1 password on the SEL device.  The default is OTTER. 

RTU Port Number: The port on the RTU connected to the SEL or 2020 device.  If the 
user’s PC is connected directly to the SEL or 2020 device, the “Direct 
from SEL Device” option should be used. 

RTU Baud Rate: If connecting thru the RTU, the baud rate between the RTU and the 
SEL or 2020 device.  The baud rate between the user’s PC and the 
RTU is fixed. 

Comm Port: The serial communications port of the user’s PC. 

20 Port: The port on the 2020 device connected to the SEL device. 

20 Password: The level 1 password of the 2020 device.  The default is also OTTER. 
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10.6 IED Library 

This menu item displays the IED Library window which is used to add IEDs stored in the 
Library into the current RTU configuration, and, to store IEDs from the current RTU 
configuration into the Library.  Thus, an IED created for one RTU can be used to configure 
many other RTUs. 

 

IED files are moved from the Library to the main ConfigWiz window, and visa-versa, using a 
drop and drop approach. 

In the Library window, the first line below the icon displays the client type of the IED.  The 
second line displays the IED’s name.  These two lines are the same as the ones shown on 

the main ConfigWiz window.  The third line displays the IED’s filename.  Placing the cursor 
over the third line reveals the IED’s full filename. 

An IED can be deleted from the Library by right-clicking on the IED’s icon and selecting 

Delete IED. 
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11 Writing the RTU File to the Platform 

11.1 About This Section 

The final step in configuring the RTU is writing the RTU file to the platform. The platform is the 
6ACP5 or 6CPP6 processor board that will use the custom configured RTU file to run the 
RTU. Writing the RTU file to the platform is the process of transferring the RTU file from the 
user’s PC to the processor board. Once the RTU file is loaded on the processor board, the 
RTU uses that configuration until another RTU file replaces it. 

11.2 Writing the RTU File 

1. Select File. The File pull-down menu displays. 

 
 

2. Select Write RTU File to Platform. The Write RTU File to Platform window displays. 

 
 

3. Select the correct serial port from the pull-down menu. The serial port is the 
communication connection between the user’s computer and the 6ACP5 or 6CPP6 
processor board.  

 

NOTE: The PC used for writing the RTU file to the platform must have the serial port 
connected to the Test port before attempting the write to platform. 
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4. Select the wait time in the Wait Time field using the increase/decrease buttons.  Wait 
Time is the amount of time (in seconds) that the PC waits for responses during data 
transfers. The default of 45 seconds should work in most cases. If time out errors 

occur, increase the Wait Time value. 

5. Select or deselect the Preserve Values check box. 

 

NOTE: The Preserve Values check box is shown only when the PLCC client is installed. 
This box must be unchecked when the user wants to erase all the AOP and DOP 
points that are part of the PLCC and are stored in non-volatile memory. Refer to the 
PLCC User Manual for more information. 

 

6. Select Write.  Before writing to the 6ACP5 or 6CPP6, ConfigWiz forces the saving of 
the RTU file if any changes have been made to the RTU configuration.  

 

  

7. After the file is saved, ConfigWiz will begin to download the file.  The download is 
complete after the platform restarts.  ConfigWiz will advise when the platform has 
restarted. 
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11.3 Writing the RTU File Over IP 

1.  Select Write RTU File to Platform from the File pull-down menu. 

 

 

2. Select the tunnel name form the Port pull-down menu.  Using the IP port and 
STunnel, ConfigWiz will use this tunnel to establish a secure connection between the 
PC running ConfigWiz and the RTU’s IP port.   

This tunnel name (or names) displayed in the pull-down menu are created as follows.  
The IP address from the Eth0Addr property of the NetConfig component is obtained.  
If the Eth0Enable property is set to enable, the tunnel configuration file is searched for 
that IP address.  If a match is found, the tunnel name having that IP address is added 
to the pull-down menu.  The same is done for the Eth1Addr and Eth1Enable 
properties. 

The Eth properties can be viewed by selecting the Ethernet tab in the NetConfig 
component window.  

The RTU and the PC used for writing to the platform must have a valid Ethernet 
connection before the write to platform is attempted. 

For more information on STunnel configuration, refer to the Configuring Tool section 
of this manual.  For more information on configuring NetConfig, refer to the NetConfig 
Addendum. 

3. Select the wait time in the Wait Time field using the increase/decrease buttons.  Wait 
Time is the amount of time (in seconds) that the PC waits for a response during data 
transfers to the 6CPP6 processor board.  The default of 45 should work in most 
cases.  If a timeout occurs, increase the Wait Time value. 

4. Select or deselect the Preserve Values check box. 

5. Select Write.  Before writing to the 6CPP6, ConfigWiz forces the saving of the RTU 
file if any configuration changes have been made to the RTU configuration. 

6. After the file is saved, ConfigWiz will begin to download the file.  The download is 
complete after the platform restarts.  ConfigWiz will advise when the platform has 
restarted. 
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12 Glossary 

 
Apparatus Physical equipment 

Bandwidth Throughput capability of a physical communication line. 

Client A computer that requests data from a server through a network. Most 
computers can perform in both capacities as client/servers. 

Command Instructs the software to perform a certain function. 

Communications 

Load 

Refers to the amount of data that is transferred from the RTU to the 
master station. 

Components Parts of the RTU; field device clients, master station servers… 

Cursor A representation of the location of the mouse in the GUI.  

Data Information used and created by the computer and software. 

Data point An individual point of the data set. 

Default Pre-configured settings that are retained unless the user modifies 
them. 

Display Representation of an item in the GUI. 

Double-click Selecting a command or icon twice in rapid succession using the left 
half of the mouse. 

Driver A program written to perform a specific function. 

Field An area in a window where information is displayed, entered, or 
modified. 

Field device Physical equipment in a system. 

File An entity used for data storage. Files are stored in folders. 

Filtering Process of identifying and retaining vital data points in the 
communication flow and dispensing non-vital data points from the flow. 

Folder Folders contain other folders or files. Folders are also called 
directories. 

GUI Graphical User Interface 

Hexadecimal An alpha-numerical system based on the numbers  0, 1, 2, 3, 4, 5, 6, 7, 
8, 9, and letters A, B, C, D, E, F. 

Icon An object in a GUI that represents a file, a software program 
executable, a shortcut to a program. Double-clicking on icons opens 
whatever the icon represents. 

IED Intelligent Electronic Device 

Mapping Configuring the routes that data will follow from client to server and 
from server to client. 

Master station A control center that contains the master station.  

Mouse Tool used with a computer for selecting GUI objects and commands. 

MS-DOS file-naming 

convention 

Standard method for naming files to be used by MS-DOS (Windows 95 
only). The file-naming convention requires that the amount of 
characters before the dot (.) not exceed eight (8) and that the extension 
(characters after the dot) not exceed three characters. 
Example: filename.ext 

Pane A section of a window. Pane is used to distinguish between parts of the 
window when, for example, there are two or more sections in a window. 

Parameter A variable that requires input from the user according to the system 
needs. 

PC Personal computer. A personal computer may be referred to as a PC 
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 or computer and may be either a desktop or laptop. 

Ports Physical serial communication channel on the 6ACP5 or 6CPP6 
processor board. 

Processor board Physical board that contains electronic components, memory cards, 
and a processor chip for processing, storing, and producing data. 

Protocol Specific method of transmitting data. 

Pull-down menu A menu that displays below a command or icon. Pull-down menus 
contain commands that the user selects to manipulate the software 
program. 

QBUS QUICS interface to support QUICS cards. 

QUICS Quindar Universal Intelligent Control System 

Right-click Selecting a command or icon by using the right of the mouse. 

RTU Remote Terminal Unit 

SCADA Supervisory Control and Data Acquisition 

Server A computer that serves data to a client. Servers may also request data 
from other computers. Most computers can perform in both capacities 
as client/servers. 

Substation A subordinate station that is remotely located from the master station. 

System Block 

Diagram 

An illustrative representation of the system that depicts all the 
equipment, location of the equipment, and specific system parameters. 

System 

Configuration 

The process of coordinating all the requirements for the master station, 
RTUs, and communication facilities. 

Tab A labeled area in a window that the user selects to display the 
information contained in that window for that particular tab. 

Template A custom-structured file that contains generic information that can be 
tailor-fit for each scenario.  

Window Display area in the GUI that displays information and enables user 
interaction with the computer and software. 
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13 ADDENDUM A 

Introduction 

The following is a detailed description of how to configure Windows 7/10 to accept USB connection to 
QEI’s DIO product line.  You will need to copy the QEI DIO Driver Folder into your user Documents 
folder or accessible folder/location. 

From main Windows Desktop enter Control Panel and then Device Manager, plug USB cable from DIO 
Main Port to PC/Laptop.  You should notice the following display change: 

 

This is good, Windows has detected the DIO.  Now click on top left Action then Add Legacy Hardware 
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 Click Next then in this dialog box select Install the hardware that I manually select then click Next 

 

Scroll down to Ports (Com & LPT) then click Next 
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CLICK ON Have Disk…. 

 

Then click on Browse…select location of QEI_Dio_Driver folder, click to enter folder then click Open 
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This dialog box should be visible, click OK 

 

Only click Next here…. 
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At this point the DIO driver is ready to be installed, click Next 
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 Windows will want to confirm, click Install 

 

 

Don’t panic…this message is expected!  Click Finish 

 

The dialog box will close and you will see this displayed- you might have to click on Ports (COM & 

LPT) 
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Now, disconnect USB cable from Pc/Laptop.  The screen will refresh but still show this message with 

warning triangle. Right Click on AT91….. and click on Uninstall Hardware then OK 

 

 

The AT91 USB to Serial Converter() will disappear.  Re-connect the USB cable , the dialog box will refresh 
and now show this: 

 

 

All good thus far.  We now have to reinstall the driver. Right Click on the 6DIO2 entry and select 

Update Driver Software then select Browse my computer for driver software 
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Looks familiar?  Windows remembers last location, but DO NOT click Next. Select let me pick from 

list of device drivers on my computer 
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…..because we Have Disk, click Have Disk 

 

Now we can click OK at this point, Windows is fussy about sequence of events (SOE’s) 

 

 

This was the problem all along, just had to get there.  Windows could not verify driver so we had to 

specifically answer the question.  Yes, it’s O.K. to install. Click on Yes 

 

Yeah, you did it….. 
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Windows assigned COM23 in this case.  Yours might be different, take note of it for use later or change 
to unused Com: port 
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Testing connection with Tera Term: 

 

 

 

 


